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Overview of The CIMAlert Message Management System 

CIMAlert is a message management system that works with CIMScan to transmit messages by way of the 
following methods:  

• Pager 
• Telephone 
• LAN e-mail 
• Internet e-mail 

You can configure a message to be sent by more than one method and to as many recipients as you wish. 

A typical use would be to transmit a message when a database point reached an alarm limit.  The message 
could include variables, like the name of the database point, the real-time data value, units of measure, 
alarm limits, plus any pre-defined text you wish. 

The basic message and the action that triggers sending it are set up in CIMScan.  The recipients and the 
methods for contacting them are set up in CIMAlert, along with a master schedule that determines how 
and if the message will be sent.  This information is passed on to CIMScan.  When you define the 
message in CIMScan, you can choose which recipients you want to receive it by simply selecting the 
names from a list.  

CIMAlert also contains a Text-to Speech option that converts the message from a text string to high 
quality speech that can be played through the telephone (if you have a telephone interface card) or 
announced over a PA system.  The telephony option also allows the recipient to request additional data by 
entering a code from a telephone key pad. 

Currently, US English is the only supported text-to-speech conversion language.  UK English, German, 
and Spanish may be offered if there is sufficient demand. 

CIMAlert Manual  Page 1 



Hardware Requirements 

CIMAlert requires a TAPI compliant telephone interface card for telephone and numeric pager support.  
Interface cards are available from your CIMScan distributor. 

For an alpha/numeric pager and Internet e-mail support, a modem must be installed and configured on the 
computer running CIMAlert. 

A sound card with the appropriate Windows drivers must be installed to be able to play messages to a PA 
system or through local speakers. 

A local area network interface is required for LAN-based e-mail. 
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Setting up CIMAlert  

Installing CIMAlert 
Before using the messaging capabilities of CIMAlert, the software must be installed.  CIMAlert does not 
install when you install the CIMScan program.  Browse the provided CD for the Setup.exe file in the 
CIMAlert directory, then proceed with a normal Windows installation.  Typically, CIMAlert is licensed 
as an option when you license CIMScan.  If you are adding CIMAlert to an existing CIMScan system, 
you must upgrade your CIMScan license.  In CIMScan, select System Settings from the File menu, click 
the License button at the bottom of the dialog, and follow the instructions on the License Management 
dialog. 

Overview of Configuring Messages and Recipients in CIMAlert 
The configuration dialogs are accessed from the Setting menu.  Each menu selection is described below. 

System.................................... A few system settings such as timeouts, logging options, time and date 
formats, etc. 

Speech.................................... Text-to-speech conversion settings such as voice to use, speech rate, 
etc. 

Constants................................ Message segments, such as an introduction and conclusion, which are 
added to each message before it is sent. 

Recipients .............................. Recipient information, including  their phone numbers, pager I.D’s, and 
e-mail addresses.  Every recipient will have a unique I.D. tag that will 
be used for identification in CIMScan.  All schedules specifying how 
and if a message should be sent are set up here.  Note:  Individual 
recipients can also log on to CIMAlert and make changes to their 
schedule as necessary.  (See Using the Recipient List Edit Utility.) 

Portals .................................... Configuration settings for each of the four message portals (pager, 
telephone, LAN e-mail, and Internet e-mail).  These settings include 
physical port selections, mail server URLs, timeouts, etc. 

Overview of Testing the Message and Recipient Set Up 
Once you have configured the recipients and the messages, you can check your setup by sending test 
messages.  Click Test in the main menu, then send a message to any recipient selected from a dropdown 
list.  This is described in detail in Testing a Configuration. 

Linking CIMScan Messages and CIMAlert Recipients 
Once you have configured CIMAlert, the final step is to start the CIMScan program and link the 
CIMScan messages to the CIMAlert recipients.  In CIMScan, access the Messages Setup dialog under 
Settings on the main menu.  Choose the desired recipient(s) for each message by selecting them from the 
list of recipient I.D.s, which is accessed by double clicking the List field on the dialog's grid.  (See 
Configuring Messages in Cimscan.) 

Configuring Telephone Message Responses 
One option with messages transmitted by telephone is allowing the recipient to request a response with 
additional data.  The response will contain a user-defined message, plus information about the selected 
database points, such as name, group ID, the current value, and the units of measure.  The response can 
be configured to either say or spell the group ID or the units of measure. 
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Response messages are configured in CIMScan.  Click the Options button on the Message Display 
Setup dialog in CIMScan.  (See Configuring Messages in Cimscan.) 
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How CIMAlert and CIMScan Interact to Send a Message 

Any CIMScan Action can send a message.  The message could be triggered by a new alarm condition, a 
change in a database point value, or by the CIMScan operator clicking a button on a graphic, to name just 
a few.   

When a message is triggered, CIMScan displays it in the User Alerts list, and plays any associated wave 
files.  Then, CIMScan sends the message to CIMAlert, along with the list of recipients linked to the 
message.  CIMScan will automatically start CIMAlert if it is not running.  (This example assumes that all 
the display options were enabled for the message in CIMScan.) 

Once received, CIMAlert checks the message to see if it should be played through a sound card.  (There 
must be a check in the Spk box on the Message Display Setup screen in CIMScan.)  If so, CIMAlert will 
immediately convert the message to a wave file format and send it to the sound card.  Next, CIMAlert 
compares the current date and time to the recipient schedules and scans the list of recipients to determine 
which are active and what mode of transmission (portal) to use.  Then, the message is queued for 
transmission to the appropriate recipients via the specified portals.   

CIMAlert's message manager periodically checks the messages in the queue and dispatches them to the 
appropriate portal handlers whenever the retry time has elapsed.  The portal handler will attempt to send 
the message and, if successful, remove it from the queue.  The message will, however, remain in the 
queue with a new retry timestamp if it cannot be sent because the telephone line is busy or there is no 
answer. 

Receiving Telephone Messages 

Telephone messages are a special case because the recipient can interact with them in real time.  After 
establishing a connection, the message is played and the recipient is prompted to enter a confirmation 
code on the telephone pad.  The message is considered sent if the correct confirmation code is entered.  If 
the message is an alarm that requires acknowledgement in CIMScan, the confirmation is transferred to 
CIMScan and the message is marked as Acknowledged in the Alarm List.   

After entering the correct code, the recipient may request additional data in the form of a canned message 
response by entering the message ID followed by the pound sign (#).  The recipient can key "0#" for a list 
of all of the available messages and their ID codes.  (Response messages are configured in CIMScan by 
clicking Options on the Message Display Setup dialog. 

The following keys are used to move through a message. 

# alone.................................... continue to next message segment 

* alone ................................... repeat last message segment 

[number] # ............................. play another message with ID=number 

A single "beep" will be issued by the system whenever a user entry is expected.  Completed entries must 
be followed by a pound sign (#) or a star (*).  (See Configuring Messages in Cimscan.) 
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Operation of CIMAlert 

Starting CIMAlert 
Double click on the CIMAlert icon on your desktop to start the application or double click cimalert.exe 
found in the CIMAlert folder in the CIMScan directory.  This will display the CIMAlert main window. 

 

 
 

Overview of CIMAlert Menus 
Across the top is a menu bar with the following items. 

File ......................................... contains options to clear the list of transaction errors (described in 
Transaction Log Display) or to exit the CIMAlert program. 

Settings .................................. accesses all message settings.  All the options under the Setting menu 
are described in Setting Menu Selections. 

Test ........................................ click to open the dialog used for message testing 

Help........................................ on-line help and version information 

Transaction Log Display 
An important part of the CIMAlert display is the list of transactions, errors and activities.  The main 
screen is split in two.  The CIMAlert transaction list is displayed on the top half.  You can choose to 
record every transaction or just the error messages.  (See System Settings.)   

CIMAlert allows recipients to log in remotely and make changes to their own schedules.  This would 
typically be used if the recipient had to take an unexpected day off or go away on a business trip.  The 
recipient client activities (logons and schedule changes) are displayed on the bottom half of the main 
screen.  See Using the Recipient List Edit Utility. 
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Click Clear List under the File menu to close the display. 
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Setting Menu Selections 

System Settings 

The System Settings dialog is used to set the transaction and error logging strategy, the time and date 
formats, and the port through which client recipients connect to CIMAlert to make changes to schedules.  
Select System from the Setting menu to display the System Settings dialog.  The dialog's options are 
described below. 

 

 
 

Time to Retry ......................... Time between retries for a busy signal or no answer. 

Date/Time Format.................. Choose the formats to use when setting up the schedules on the 
Recipient Settings screen. 

Path to Log Files .................... Select or enter the path to the files that will log the errors or, optionally, 
all transactions.  Double click on the field to navigate to a new folder.  
The actual log file names contain the date and are changed daily at 
midnight. 

What to Log ........................... Check what to log.  All Transactions will record each step of sending a 
message.  SMTP Errors refers to sending e-mail over the Internet.  All 
Other Errors will log any errors generated when using other methods.  
See Transaction Log Display. 

Max Entries in List ................ Enter the maximum number of entries to display in the list on the main 
screen.  When that limit is reached, the oldest entry will be removed 
when a new one is added. 
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List All Trans ......................... Check to list all transactions on the main screen, in addition to errors. 

Output to speakers ................. Normally left unchecked.  Checked only if you are having problems 
broadcasting a text to speech message over a speaker system.  When 
checked, the text to speech message is converted to a .WAV file for 
output to the speakers. 

Listen on Port......................... Port through which client recipients connect to change their schedules.  
The port (as well as the IP address) must be saved in the RListEdit.ini 
file in the CIMAlert directory so that recipients can log on..  
(RListEdit.ini  can be edited by Notepad or Wordpad.)  The port 
number may be any number you like so long as it is not be used by any 
other device or application.  It is not a physical port. 

IP Address.............................. This is the computer's IP address.  It must be included in the 
RListEdit.ini file, along with the port number.  For informational 
purposes only. 

Host NamE............................. Name of the computer that is running CIMAlert.  For informational 
purposes only. 

Speech Settings 

Select Speech from the Setting menu to access the Speech Settings dialog and configure the text-to-
speech subsystem.  The options in the dialog, described below, control how the message will sound. 

 

 
 

Voice...................................... Select one of eight possible voices. 

Speech Rate............................ The default speech rate is 180 words per minute. 

Comma Pause ........................ The number of milliseconds to add to the default 160 msec. pause after 
a comma. 

Period Pause........................... The number of milliseconds to add to the default 640 msec. pause after 
a period. 

Click the Test button at any time to play a test message through a local sound card (if available). 

 

Constants Settings: Configuring Pre-defined Message 
Components 

Pre-defined message segments can be automatically inserted in various parts of a message.  Select 
Constants for the Setting menu to access Constant Message Components dialog. 
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The Message Components that may be defined vary with the sending method.  For instance, a telephone 
message may incorporate the following components: Introduction, Confirmation, Prompt, 
Confirmation Failure, Data Prompt, and Conclusion.   Click the tabs across the top, Pager, 
Telephone, E-Mail, or Internet, to enter the text appropriate for each sending method. 

Recipients 

Overview 
The Recipient selection from the Setting menu accesses dialogs for setting up recipient information and 
message delivery schedules.   

Recipient information includes names, IDs, passwords, and group affiliation.  The ID and group are used 
in CIMScan when choosing recipients for messages.  You can choose individual message recipients or 
opt to send the message to all members of a group.  The ID and password are used by individual 
recipients to log on to CIMAlert from a remote computer to make modifications to their own schedules 
without involving the CIMAlert system administrator.  This allows a recipient to select an alternate 
delivery method for messages if, for example, they take an unexpected day off.  They can also forward all 
their messages to another recipient during a specific time frame. 

The scheduling mechanism in CIMAlert is quite sophisticated.  There is a master schedule of work days 
and holidays that applies to all.  Then, individual schedules are set up that apply to each recipient.  These 
include sending methods (email, pager, or telephone) to use during working and non-working hours, 
vacation schedules when all messages can be forwarded to another recipient, and exception schedules 
when messages are sent to the recipient but by an alternate sending method.   

To determine how to send a message, CIMAlert checks the schedules in the following order.  

1. The contents of the message is checked to see if it contains a tag that limits to whom the 
message is sent.  (See Using Tags to Filter Messages.)  If there is no tag that inhibits sending 
the message... 

2. The recipient's vacation is checked.  If on vacation, the message will be forwarded to the 
designated recipient.  If not on vacation... 

3. The exception schedule is checked and, if valid, the message sent by the alternate schedule.  If 
exceptions don't apply... 

4. The holiday schedule is checked.  If it is a holiday, the message will be sent by the method 
designated for non-working hours.  If not a holiday... 

5. The work schedule is checked and the message sent by the method designated for working 
hours. 
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Defining Recipient Names, IDs and Passwords 
Select Recipients from the Setting menu to define the list of recipients, the methods for contacting them, 
and their schedules.  The first time you open the List of Message Recipients dialog, the window will be 
blank, except for the headings Recipient's Name, ID, etc. 

 

 
 

Right click in the blank area to display a popup menu, then select Add Row.   
 

 
 

You will be prompted to enter the number of rows to add.  Add one row for each recipient you want to set 
up. 
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First, enter the recipient information in the following fields: 

Recipient's name .................... Enter the full name of the recipient. 

ID ........................................... Enter a short ID tag for the recipient.  This ID will be added to the 
recipient list in CIMScan that is used to select recipients for a message.  
It is also used when recipients log on remotely to make a change to 
their schedule. 

OK ......................................... Check to enable the recipient. 

Group ..................................... Enter or select the Group to which the recipient belongs.  Groups allow 
you to easily send a message to several people at once. You simply 
select the group name in CIMScan when defining the recipients, rather 
than the individual names. 

Password ................................ Enter the password the recipient can use to remotely access his or her 
own recipient settings and make changes.  This feature would be used 
if, for instance, the recipient was unexpectedly called out of town for a 
day and wanted to redirect messages to another person.  Each character 
in the password will be replaced with a * once you exit the field. 

Last Update ............................ This accesses the dialogs for setting up the message delivery schedules 
for individual recipients.  The date and time the schedules were last 
updated is displayed in this field. 
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Master Schedule for Work Days and Holidays 
The Master Schedule is where you set up the general work schedule and the standard holidays that apply 
to all.  Click the Master Schedule button at the bottom to access the Recipients dialog.  

 

 
The Workdays are defined in the top half.  Add rows, if necessary, then click the Active Date Range 
field and the button to define the time period for the schedule.  Check off the days of the week which are 
workdays.  Finally, click the Starting and Ending Times to select the hours worked during the selected 
days. 
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Holidays are defined in the bottom half of the dialog. For each Holiday, define the Starting and Ending 
Date and Time, then enter a Holiday Name to identify it.  Click Apply to save the schedules. 

Setting Up Vacation Schedules 
After setting up the general work and holiday schedules, you need to define vacation schedules for each 
recipient.  Once you have set up the name, ID, etc. for a recipient, click the Last Update field, then the 
button to display the Detailed Delivery Settings dialog. 

 

 
 

The dialog will open to the General Settings tab where you set up the vacation schedules.  The 
recipient's name and ID are displayed at the top.  During the vacation period, you may have all messages 
forwarded to another recipient.   

The first time you access this dialog for each recipient, you must right click in the blank area and select 
Add Row from the popup menu, then enter the number of rows you need, one row for each vacation time 
period.   
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To define the beginning of the vacation, click the Starting Date & Time field, then the button to display 
the Set Date and Time dialog. 

 

 
 

Either enter the start date in the Date field or click the down arrow and select a day from a calendar.  Use 
the arrows at the top of the calendar to change the month. 

 

 
 

Enter the start time in the Time field or click the down arrow and drag the slide bar that appears to select 
a new time. 

 

 
 

Clicking the arrows at either end of the slide bar will add or subtract a minute.  Click Set to save the time, 
then Apply to return to the General Settings dialog. 

Define the Ending Date & Time the same way.   
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In the Forward To field, type in the ID of the person to receive the messages during the vacation period. 
 

 
 

Using Tags to Filter Messages 
The General Settings screen of the Detailed Delivery Settings dialog also contains a section for 
defining message Tags.   

 

 
 

Tags are a handy way to filter messages and send only those of interest to the recipient.  Tags may be 
defined in three ways.  Click the down arrow above the Tag section of the screen and select one of the 
following options: 

Ignore all the tags contained in the message 

Deliver message only if the following tags Exist 

Deliver message only if the following tags Do Not Exist 
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The easiest way to explain how Tags can be used is to give an example.  Suppose CIMScan is monitoring 
the temperature in several laboratories.  You want to send an alarm message whenever the temperature 
exceeds the alarm limit.  You want to apply the message to every lab in the building but only want to 
send the message to the lab manager in charge of the lab that is in alarm.   

The way to do this is to define each lab as a separate database Group in CIMScan and incorporate the 
Group name into the alarm message as a variable.  If you put the Group variable within {   }, it is also 
recognized as a Tag in CIMAlert.   

The following shows a simple version of a message that you could set up in CIMScan.   

The temperature in Laboratory {[:GROup]} is in alarm.  The temperature is [:VALue] 

[:GROup] and [:VALue] are variables and the actual group name and temperature value will be inserted 
into the message.  The Group variable will also be treated as a Tag.  (Note:  The group referred to here is 
a CIMScan database group, which is not the same as a CIMAlert recipient group.  See the CIMScan 
User's Manual for details on setting up messages.)   

Then, in CIMAlert, select Deliver message only if the following tags Exist.  As you set up the lab 
managers as the Recipients in CIMAlert, define the text of the Tag as the Group name that corresponds 
to their laboratory.  If the message contains the Group name of their lab, they will receive the message.  
They will not receive messages concerning the other laboratories. 

To enter the text for the Tags, right click in the blank area in the Tag section and select Add Rows from 
the popup menu.  Enter the number of rows you need, one for each Tag.   

 

 
 

Then, type in the text you want to use for the tag, like Lab 101.  The message will be sent only if Lab 
101 is the Group name. 

Setting Up the Daily Delivery Schedules 
After defining normal working hours, holidays, and vacation schedules, you need to set up the message 
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delivery schedule that will be used daily for individual recipients.  If the Detailed Delivery Settings 
dialog is open, simply click the Delivery tab.  Otherwise, select Recipient from the Setting menu, select 
the Last Update field for one of the reciptients to display the Detailed Delivery Settings dialog.   

The dialog is used to define delivery methods for working hours and for time when not at work (typically 
nights and weekends).  In addition, you can set up exceptions to the normal delivery schedule for days 
off, business trips, etc.  (Individual recipients may log onto this screen with the proper password, and 
make changes to their own schedules.  See Using the Recipient List Editor Utility to Change 
Schedules Remotely.) 

 

 
 

Start by selecting the work schedule. Click the button next to the Work Schedules to display the 
schedules previously set up. 

 
Add check marks to the Pick field for the schedules you want to use and click Apply to save your 
selections and return to the Delivery Settings screen.   

Then, click the button for WORKDAY delivery methods to open the Portal  dialog to set up the 
sending method. 
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Select the Portal field and select a Portal from a dropdown list and enter an email address or phone 
number.  Enter as many portals as necessary, then click Apply. 

 
Finally, define the exceptions to the standard schedule.  Use this schedule for planned days off, business 
trips, etc.  Note: Individual recipients can log in to CIMAlert to make minor changes to their own 
schedule.  This is handy for sick days and other unexpected days off.  See Using the Recipient List Edit 
Utility. 

The first time you access this screen, you must right click in the blank area, select Add Rows from the 
popup menu and enter the number of rows you need, one row for each different date range, time range, 
and/or method of sending. 

 

 
 

Select the Date Range, Time Range, check off the appropriate days of the week, then click the Method 
field to define the portal and phone number or address. 
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When the Delivery Schedule is complete, click the Apply button to save all your settings for the 
recipient and to return to the List of Message Recipients screen.   

 

 
Then, click the OK button at the bottom of the screen to save the configurations. 

Portals Settings 

Clicking on the Portals menu item in the Setting menu will display a tabbed dialog box for configuring 
each of the four message ports: Pager, Telephone, E-Mail, and Internet.    
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Pager Portal Settings 

 
 

Click Pager tab on the Portal Settings dialog and define the following. 

Pager Type ............................. Numeric or Alpha/Numeric. 

Device .................................... Select the I/O hardware (TAPI interface or modem). 
 
For communicating with numeric pagers, CIMAlert supports both 
voice modems and telephone interface cards.  In either case, the 
hardware must be TAPI compliant. 
 
Alpha/Numeric pagers work with standard data modems.  If you 
selected Alpha/Numeric as the Pager Type, the Device field changes to 
a COM Port selection field. 

Phone # .................................. Telephone number for the alpha/numeric pager service only.  (The 
phone number for a numeric pager is associated with a specific 
recipient and is set up under Recipients.) 

Send Delay............................. Number of seconds the system should delay after establishing the 
connection before sending the message.  (Not required with data 
modems, which use a built-in connection protocol.) 
 
If you are using a voice modem, the Send Delay is necessary because 
the “connection” is made as soon as the dialing operation is complete, 
NOT when the paging service answers OR when it beeps to signal that 
you may leave a number.  This means the Send Delay must be long 
enough to allow the paging service to answer the phone and play its 
standard message before the system transmits the CIMAlert message to 
the pager.  
 
If you are using a telephone card, the connection is made when 
someone answers the call.  In this case, the Send Delay must be long 
enough to allow the paging service to finish playing its standard 
message before the pager message is sent from CIMAlert.  

Connect T'out......................... Number of seconds the system will wait for the paging service to 
answer the phone and establish a connection.  This setting is for 
telephone interface cards only. 
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# Retries ................................. Number of times to retry on busy signal or no answer before giving up 
and logging an error. 

Telephone Portal Settings 
 

 
 

Click the Telephone tab on the Portal Settings dialog and define the following. 

Device .................................... Select a TAPI compliant telephone interface device.  This could be a 
modem or a phone card.   

Call Strategy .......................... Select to Call everyone or Stop after first contact is made. 

No Ans. Timeout.................... Number of seconds to wait before hanging up when there is no answer. 

# Retries ................................. Number of retries before aborting call. 

Confirmation.......................... The call confirmation code entered by the recipient. 

Max Conf. Retries.................. Number of times the system will allow the recipient to try entering the 
correct confirmation code. 

Volume .................................. Enter 0 to use the default volume setting.  Enter a number greater than 
50 to make it louder and less than 50 to make it softer. 

Requests for .......................... Choose whether or not requests for additional data are allowed. 

LAN E-Mail Portal Settings 
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Click the E-Mail tab on Portal Settings dialog and define the following. 

System Type .......................... Select the type of LAN mail system you will connect to 

Post Office ............................. Name of post office 

Login Name ........................... Your usual login name for the mail system 

Password ................................ Your mail system password 

Name Delimiter...................... Character that separates names when sending a message to multiple e-
mail recipients. 

Internet E-Mail 
 

 
Click the Internet tab on the Portal Settings dialog and define the following.  

Server URL............................ The URL for your Internet service provider's mail server 

Phone # .................................. The telephone number of your ISP 

User Name ............................. The name you use to log onto the mail server 

Password ................................ Your mail system password 

Connect Timeout.................... Timeout period, in seconds, to establish a connection 

Protocol Timeout ................... Timeout period, in seconds, to wait for a message response 
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Name Delimiter...................... Character that separates names of recipients.  (Used when sending a 
message to multiple e-mail recipients.) 

SMPT Port ............................. Usually set to 25 
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Testing a Configuration 

You can easily test a configuration by clicking the Test on the main menu to display the Test 
Configuration dialog. 

 

 
 

You can check three different aspects of your configuration: the contact method, the way the message 
sounds when converted to speech, and the scheduling setup.  To check the contact methods for the 
individual recipient, select a name from the Recipient field dropdown list.  Type a short message in the 
Message box and click Test.  The message will be transmitted via all the methods enabled for the 
recipient.  The list of transactions and errors will be displayed on the main screen when you send the 
message, showing where and how the message was sent.  Click the Erase button to clear the transaction 
log from the main screen. 

 

To hear what a text-to-speech message sounds like, select [Speech] as the recipient.  The test message 
will be sent to your local sound card. 

 

To check the scheduling for a recipient, put a check in the Test how to send message… box.  The 
Message  box now becomes the Date Time box.  In this case, the message is not actually transmitted. 

 

 
 

Enter the date and time you wish to check and then click Test.  CIMAlert will check the schedules for the 
recipient.  The transaction log will list where and how the message would be sent at the time and date 
entered for the test.  
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Configuring Messages in CIMScan 

Start the CIMScan software if necessary.  Access the Message Display Setup dialog by selecting it from 
the Setting menu in CIMScan.   

 

 
 

Create your message as outlined in the CIMScan documentation.  To send the message through CIMAlert 
you must check the Snd box.  To convert the message from text to speech, you must check the Spk box. 

 

Then, double click on the recipients List field.  This will display the Tag List dialog where you add and 
remove the recipients of the message.   

 

 
 

The IDs of all the recipients set up in CIMAlert will appear in the list under Available Tags on the left.  
Click on a name that you want to receive the message then click Add to move it to the Tags Currently in 
List to the right.  Use the Remove button to subtract a recipient from Tags Currently in List.  Click 
Apply to save the entries. 

With telephone messages, you can configure response messages that can be accessed by the recipient if 
they key in the message ID on the telephone keypad.  Click the Options button on the Message Display 
Setup screen to the display the Message Port Settings dialog.  Click on the Phone Responses tab to 
display the configuration screen with the following fields. 
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Response Name...................... The name played just before the response 

OK ......................................... Checked if the response is enabled 

Code....................................... The numeric code used to request the response 

Gspk....................................... Checked to say the ID of the group 

Gspl........................................ Checked to spell the ID of the group 

Uspk....................................... Checked to say the units of measure 

Uspl........................................ Checked to spell the units of measure 

DB Points............................... Double click here select the database points to include in the message.  
This will display the database point selection dialog, described in the 
CIMScan documentation. 

 

There is no limit, other than system resources, to the number of responses that can be configured.  (See 
Receiving Telephone Messages.) 
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Using the Recipient List Editor Utility to Change Schedules 
Remotely 

The Recipient List Editor Utility is provided with CIMAlert so that individuals can make changes to their 
own schedules and message sending methods without involving the person who administers CIMAlert.  
This would typically be used to take care of unexpected absences from work, to make changes in vacation 
schedules, etc.  Before a schedule can be changed, the recipient must log-on to the CIMPrint program 
with their recipient ID and password.   

Before a recipient can log onto the host computer running CIMAlert, the RListEdit.ini file must be set up 
correctly with the port and IP address information.  The System Settings dialog contains both pieces of 
information.  The RListEdit.ini file is found in the CIMAlert directory.  To edit it, simply open it in 
Notepad or Wordpad, make changes as necessary, and save it.  The contents of a typical RListEdit.ini file 
looks like this: 

100 
127.0.0.1 

where 100 is the port and 127.0.0.1 is the IP address. 

To start the utility, open Windows Explorer and double click on the file RListEdit.exe. in the CIMAlert 
folder.  This will open the log on dialog. 

 
Enter your Recipient ID and your Password.  When you click Open, the information is checked and if 
correct the Detailed Delivery Settings dialog will open.  (Note:  CIMAlert must be running on the host 
computer or you will get a connection error message.) 

The dialog has two tabs: General Settings, where you can set up a schedule to forward all your messages 
to another recipient during vacations, and Delivery Schedule, where you can define how to send 
messages during working and non-working hours, as well as set up exception schedules. 
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See Setting Up Vacation Schedules and Setting Up the Daily Delivery Schedules for details on how to 
use these dialogs.  The only difference between the dialogs accessed directly from CIMAlaert and those 
accessed remotely by recipients is the they are not allowed to change the general work schedule that has 
been assigned to them (Work Schedules to Use field). 

When finished setting up your schedules, click Apply to save all your changes.  This will return you to 
the log-on dialog. 

 
A message confirming that the information was received by the CIMAlert server will be displayed in the 
dialog.  If there were any communication problems, an error message will be displayed.  Click Exit to 
close the dialog. 
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Appendix A:  Step by Step Instructions For Setting Up Paging, 
Telephone, and E-Mail Messages 

The following instructions step you through setting up each method of transmitting messages, screen by 
screen.  Though all the setups are similar, each one is described in its entirety.  It is assumed that you 
have set up the System Settings in CIMAlert and enabled the necessary system options in CIMScan.  (In 
CIMScan, see the Options tab in System Settings under the File menu).   

 

After you configure CIMAlert to send a message, it is a good idea to check your setup by clicking the 
Test menu option at the top of the screen. 
 

Please refer to the other sections of this manual and the CIMScan documentation for details not covered 
in these instructions. 

Numeric Pager - Step by Step Instructions 

Since numeric pagers can only accept numbers, with no spaces or text, the messages you can send are 
very limited.  Typically, you would send a phone number that the recipient could call for further 
information.  Other possibilities include the reference number of a database point, a data value (whole 
numbers only), or a code number indicating that a particular alarm has occurred. 

CIMAlert 

In CIMAlert, select Recipient from the Setting menu.  If necessary, define the recipient's name, ID, and 
password.  Select the Update field to access the Delivery Settings screen.  Click the Delivery Schedules 
tab and define the date and time period that you wish to send messages by numeric pager.  Then, click the 
Method field to set up the numeric pager as the delivery method.  Select Pager as the Portal and enter 
the phone number.   

Select Portals from the Setting menu, then the Pager tab.  Choose Numeric as the Pager Type and 
select the Device (must be a TAPI compliant modem or phone card) to use to send the message.  Enter 
times for the Send Delay, and Timeout, depending on the type of device.  Enter the number of times to 
try to connect to the pager when there is no answer or a busy signal. 

CIMScan 

Under the Setting menu, select Messages Setup.  Give the message a name and check the Snd (send) 
option.  In the Message field, enter the numbers you want to appear as a message on the recipient’s pager.   

Alternatively, you can click on the Message field, click the Edit button and choose variables to send as a 
message, such as database point value, group ID, or total number of alarms.  Because numeric pagers 
only accept numbers, only variables that are expressed as whole numbers will be transmitted 
correctly.  (See the CIMScan Manual or the Message Setup Addendum for details on setting up messages 
with variables.) 

Double click the List field and select the recipients for the message. 

Finally, set up the Action that will trigger sending the message.  Access the screen where you want to set 
up the Action that will trigger the message.  Actions may be tied directly to a database point, an alarm 
strategy, a user input, etc.  Action fields appear on the following setup screens:   
 

Alarm Strategies 
Database Settings 
Alarm Strategies 
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User Inputs Setup 
Actions Menu 
Graphic Display Setup 
Pacer Settings (under the File menu) 
 

Set up an Action to send a message by double clicking the Action field.  In the Actions dialog, click the 
Add button.  Under What to act on, choose Display and Message, then choose the name of the pager 
message.  Make the appropriate selection under Act when, then choose Display or Send Message under 
Action to take. 

Alpha/Numeric Pager - Step by Step Instructions 
There are only minor differences between setting up numeric and alpha/numeric pagers.  Because you can 
send text to the alpha/numeric pagers, defining the message can be more complex.  Also, alpha/numeric 
pager recipients share one phone number, but require individual addresses. 

CIMAlert 

Select Constants from the Setting menu in CIMAlert.  Click the Pager tab, then enter the text you want 
to appear as an introduction and conclusion for each message.  (Consider the number of characters 
allowed by your pager when you set up message components.) 

Select Recipient from the Setting menu.  If necessary, define the recipient's name, ID, and password.  
Select the Update field to access the Delivery Settings screen.  Click the Delivery Schedules tab and 
define the date and time period that you wish to send messages by alpha/numeric pager.  Then, click the 
Method field to set up the alpha/numeric pager as the delivery method.   

Select Portals from the Setting menu, then the Pager tab.  Choose Alpha/Numeric as the Pager Type 
and select the Device (modem) to use to send the message.  Enter the phone number for the pager, then 
enter a time for the Send Delay (only necessary for a voice modem).  The Timeout field does not apply.  
Input the number of times to try to connect to the pager when there is no answer or a busy signal. 

CIMScan 

Under the Setting menu, select Messages Setup.  Give the message a name and check the Snd (send) 
option.  In the Message field, enter the text you want to appear as a message on the recipient’s pager.   

Alternatively, you can click on the Message field, click the Edit button and choose variables to embed in 
the message.  Database point name and value, units of measure, group name, and total number of alarms 
are a few of the variables that can be included in the message.  (See the CIMScan Manual or the Message 
Setup Addendum for details on setting up messages with variables.)  Make sure your pager can 
accommodate the length of the message, plus the message components from CIMAlert. 

Double click the List field and select the recipients for the message. 

Finally, set up the Action that will trigger sending the message. 

Access the screen where you want to set up the Action that will trigger the message.  Actions may be tied 
directly to a database point, an alarm strategy, a user input, etc.  Action fields appear on the following 
setup screens:   

Alarm Strategies 
Database Settings 
Alarm Strategies 
User Inputs Setup 
Actions Menu 
Graphic Display Setup 
Pacer Settings (under the File menu) 
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Set up an Action to send a message by double clicking the Action field.  In the Actions dialog, click the 
Add button.  Under What to act on, choose Display and Message, then choose the name of the pager 
message.  Make the appropriate selection under Act when, then choose Display or Send Message under 
Action to take. 

Telephone - Step by Step Instructions 
The setup for Telephone messages is more involved than the others because you must configure the text-
to-speech parameters as well. 

CIMAlert 

Select Speech from the Setting menu.  Choose the Voice for the message, as well as the Speech Rate 
and the pauses for commas and periods.  It is a good idea to click the Test button to check how a message 
will sound. 

Select Constants from the Setting menu and click the Telephone tab.  Because recipients are able to 
interact with telephone messages, there are several message segments to set up.  In addition to the 
introduction and conclusion, you may enter prompts for entering the confirmation number or requesting 
more data, as well as a message to play when the recipient responds with an incorrect number.  Use the 
scrollbar at the side of the dialog box to access the message options that are not visible. 

Select Recipient from the Setting menu.  If necessary, define the recipient's name, ID, and password.  
Select the Update field to access the Delivery Settings screen.  Click the Delivery Schedules tab and 
define the date and time period that you wish to send messages by alpha/numeric pager.  Then, click the 
Method field to set up telephone as the delivery method.   

Select Portals from the Setting menu.  Under the Telephone tab, select the Device, either a modem or 
telephone card, and choose the Call Strategy (call everyone or stop after the first contact).  Enter the 
number of seconds to wait before hanging up when there is no answer and the number of times to retry if 
there is no answer or a busy signal.  Then enter the Confirmation code number and the number of times 
the recipient can attempt to enter it.  Select whether the recipient can request more data or not. 

CIMScan 

Under the Setting menu, select Messages Setup.  Give the message a name and check the Snd (send) and 
Spk (speak) options.  In the Message field, enter the text you want to be spoken over the telephone.   

Alternatively, you can click on the Message field, click the Edit button and choose variables to embed in 
the message.  Database point name and value, units of measure, group name, and total number of alarms 
are a few variables that can be included in the message.  (See the CIMScan Manual or the Message Setup 
Addendum for details on setting up messages with variables.)   

Double click the List field and select the recipients for the message. 

Finally, set up a Action to trigger the message.  Access the screen where you want to set up the Action 
that will trigger the message.  Actions may be tied directly to a database point, an alarm strategy, a user 
input, etc.  Action fields appear on the following setup screens:   

 
Alarm Strategies 
Database Settings 
Alarm Strategies 
User Inputs Setup 
Actions Menu 
Graphic Display Setup 
Pacer Settings (under the File menu) 
 

Set up an Action to send a message by double clicking the Action field.  In the Actions dialog, click the 
Add button.  Under What to act on, choose Display and Message, then choose the name of the pager 
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message.  Make the appropriate selection under Act when, then choose Display or Send Message under 
Action to take. 

E-Mail - Step by Step Instructions 

The setups for LAN (local area network) and Internet e-mail messages are virtually identical.  This 
section will describe both.  Both require an SMPT server. 

CIMAlert 

Select Constants from the Setting menu in CIMAlert.  Click either the E-mail or Internet tab, then enter 
an e-mail address in the From and Reply To fields.  Enter a Subject and any text you want to appear as an 
introduction or conclusion for each message.  

Select Recipient from the Setting menu.  If necessary, define the recipient's name, ID, and password.  
Select the Update field to access the Delivery Settings screen.  Click the Delivery Schedules tab and 
define the date and time period that you wish to send messages by alpha/numeric pager.  Then, click the 
Method field to set up the alpha/numeric pager as the delivery method.   

Select Portals from the Setting menu.  The portal settings are different for each type of e-mail message. 

For a LAN setup, click the E-mail tab and select the type of e-mail system.  Enter the Post Office, your 
Login Name and Password, then a delimiter to separate the names on messages sent to multiple 
recipients. 

For e-mail sent over the internet, click the Internet tab and enter the URL and phone number for the 
Internet Service Provider (ISP) that handles the e-mail.  Enter the User Name and Password required to 
send e-mail.  Enter the number of seconds for the timeouts in the Connect and Protocol fields, a name 
delimiter, and the value for the SMTP field (usually 25).  

CIMScan 

Under the Setting menu, select Messages Setup.  Give the message a name and check the Snd (send) 
option.  In the Message field, enter the text you want to appear as a message.  

Alternatively, you can click on the Message field, click the Edit button and choose variables to embed in 
the message.  Database point name and value, units of measure, group name, and total number of alarms 
are a few variables that can be included in the message.  (See the CIMScan Manual or the Message Setup 
Addendum for details on setting up messages with variables.) 

Double click the List field and select the recipients for the message. 

Access the screen where you want to set up the Action that will trigger the message.  Actions may be tied 
directly to a database point, an alarm strategy, a user input, etc.  Action fields appear on the following 
setup screens:   

 
Alarm Strategies 
Database Settings 
Alarm Strategies 
User Inputs Setup 
Actions Menu 
Graphic Display Setup 
Pacer Settings (under the File menu) 
 

Set up an Action to send a message by double clicking the Action field.  In the Actions dialog, click the 
Add button.  Under What to act on, choose Display and Message, then choose the name of the pager 
message.  Make the appropriate selection under Act when, then choose Display or Send Message under 
Action to take. 
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Appendix B:  E-Mail Diagnostics 

Setting up an e-mail system can sometimes be a daunting task because of all of the details that must be 
covered completely.  A special e-mail diagnostic program is provided with CIMAlert to help solve any e-
mail related problems.  If you have problems, run the diagnostic program as described below and e-mail 
the results to Technical Support. 

 

Start the diagnostic from the Olesvr folder in the Windows System directory using Windows Explorer.  
(The path is typically C:\Windows\System32\Olesvr\.)  Double click the file named Maildi32.exe to 
display the IDS Mail System Diagnostics screen. 

 

 
 

Make sure 32-bit is selected (CIMAlert does not support 16-bit), then click on Select Mail Systems to 
Test.  This will display the IDS Mail System Analyzer dialog with an extensive list of E-mail systems. 

 

 
 

Check those that you plan to use, then click OK to return to the main screen. 
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If one of your selections was Internet Mail (SMTP/POP), the Internet Settings dialog will need to be 
filled in.  Back at the main screen, click Internet Settings (SMTP/POP) to display the Internet Mail 
Preferences dialog. 

 

 
 

Enter your server names, login name, and password.  (At the present time, CIMAlert only supports 
outgoing e-mail messages.  Support for CIMScan data requests via incoming e-mail will be added in the 
future.)  Close the Internet Settings dialog by clicking on OK. 

 

Once back at the main screen, perform the e-mail test by clicking on Run Tests.  This will display a 
diagnostic summary in Windows Notepad similar to the one below. 

 

INFO: All tests were passed successfully. 

  

     ****************** Technical Data ****************** 

  
[General] 
DiagApplicationVersion32=3.01 
DiagApplicationPath32=C:\WINDOWS\SYSTEM\OLESVR 

Date=9/12/99 5:43:30 AM 
 
[SystemInformation] 
Path=C:\WINDOWS;c:\windows\COMMAND;C:\DOS 
Temp=C:\windows\TEMP 
OSType=95 
Running3.1=False 
RunningNT=False 
Running95=True 
 
[TestedSystems] 
Internet=True 
 
[IDSMail] 
 
[IDSMail32] 
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StartUp=True 
ServerVersion=5.12 
ServerPath=C:\WINDOWS\SYSTEM\OLESVR 
NativeMailSystem=1 
VINES=False 
VIM=False 
MHS=False 
MAPI=True 
SMTP=True 
ActiveMessaging=False 
ActiveMessagingVersion=0 
 
[LicenseCheck] 
GoodCount=1 
BadCount=0 
 
[MAPI] 
 
[MAPI32] 
 
[VIM] 
 
[VIM32] 
 
[MHS] 
 
[VINES] 
 
[WINSOCK] 
 
[ActiveMessaging] 
 
[ActiveMessaging32] 
 
[Dialer] 
 
[IDSDial] 
 
[LotusMail] 
Program= 
 
[cc:Mail] 
ProgramPath= 
User0Name= 
User1Name= 
User2Name= 
LastIDUsed= 
LastUserID= 
ProgVer= 
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